
Welcome to Data Wrangling!

• Check the BANA 7025 HW Groups in Canvas, 
to see which group number you belong to.  
Find your group’s number and sit there. (Please 
introduce yourself to your group.)

• Download the material for today’s class on the 
course website 
(https://xiaoruizhu.github.io/data-
wrangling/week-1).



DATA WRANGLING WITH R
Welcome!



INTRODUCTIONS



FIRST THINGS FIRST…
Please call me Xiaorui or Jeremy.

Doctor
Professor
Mister



Xiaorui Zhu
In a previous life…



COURSE OBJECTIVES
• Perform your data analysis in a literate programming environment

• Import and manage structured and unstructured data

• Manipulate, transform, and summarize your data

• Join disparate data sources

• Methodically explore and visualize your data

• Perform iterative functions

• Write your own functions

• Get an introduction to machine learning

…all with R!



Lots of hands-on coding exercises



You will be overwhelmed!



Strong proponent of 
collaborative work!



CLASS MATERIAL
https://xiaoruizhu.github.io/data-wrangling/

• All material online
• Tutorials, resources, & 

exercises
• Any info regarding class 

prep

https://uc-r.github.io


CLASS GRADING
Engagement 10% Homework Assignments 20%

Final Project 50%

• In class discussion
• Canvas discussions
• Small group activities

• Fully reproducible HTML report
• Imports, cleans, prepares, 

explores publicly available data
• Helps to build your portfolio

Mid-term Project Eval 20%

• HTML report via R Markdown
• Completes items 1.1-3.5 of the 

grading rubric
• Helps to build your final project

• Must be completed by Mon @ 
9am

• Group homeworks!
• Submit via Canvas



TENTATIVE SCHEDULE
Week Date Topic

Readings to complete 

BEFORE class
Due

1 Oct 18

Introduction & Base R

• Intro to the course, R, and RStudio

• Base R and Data Cleaning

2 Oct 25

First Date Guidelines for Data

• Reproducible documents and workflow management

• Importing data and getting to know it

• Chapter 27 of R for Data Science (R4DS), 

sections 27.1 through 27.5

Homework #1

(Due Nov 1 @ 9AM)

3 Nov 1

Tidy Data and Data Manipulation

• Tidying & preparing data for analysis

• Data manipulation

• Chapter 12 of R4DS, sections 12.1 through 12.5

• Chapter 5 of R4DS, sections 5.1 through 5.4

Homework #2

(Due Nov 8 @ 9AM)

4 Nov 8

Data Transformation

• Relational data

• Leveraging the Tidyverse to simplify data wrangling

• Chapter 5 of R4DS, sections 5.5 through 5.7

Mid-term Project 

Evaluation

(Due Nov 15 @ 12:50PM)

5 Nov 15
Data Visualization

• Data visualizations
• Chapter 3 of R4DS, all sections

Homework #3

(Due Nov 22 @ 9AM)

6 Nov 22

Creating Efficient Code

• Control statements and iterations

• Writing functions

• Chapter 19 of R4DS, sections 19.1 through 19.6

• Chapter 21 of R4DS, sections 21.1 through 21.5

Homework #4

(Due Nov 29 @ 9AM)

7 Nov 29

Introduction to Applied Modeling

• Unsupervised learning

• Supervised learning

• Chapter 22 of R4DS, all sections

• Chapter 23 of R4DS, all sections

Final Project Due

(Due Dec 04 @ 11:59PM)
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COMMUNICATION

Teams (and Canvas)
• Different channels for different weeks

• Teams is the first place to go to ask questions

• Share code, scripts, files, resources

• Talk bad about the instructor

• I check multiple times per day but am not on 
continuously



PROGRAMMING & ANALYSIS

Download and install R, a free software environment for statistical computing and 
graphics from CRAN, the Comprehensive R Archive Network. It is highly 
recommended to install a precompiled binary distribution for your operating 
system; follow these instructions:

1. Go to https://cran.r-project.org/
2. Click “Download R for Mac/Windows”
3. Download the appropriate file:

• Windows users click Base, and download the installer for the latest R version
• Mac users select the file R-3.X.X.pkg that aligns with your OS version

4. Follow the instructions of the installer.



PROGRAMMING & ANALYSIS

Install RStudio’s IDE (stands for integrated development environment), a 
powerful user interface for R. RStudio includes a text editor, so you do not 
have to install another stand-alone editor. Follow these instructions:

1. Go to RStudio for desktop 
https://www.rstudio.com/products/rstudio/download/

2. Select the install file for your OS

3. Follow the instructions of the installer.
There are other R IDE’s available: Emacs, Microsoft R Open, Notepad++, etc; 
however, I have found RStudio to be my preferred route. When you are done 
installing RStudio click on the icon.



QUESTIONS ABOUT THE CLASS?



FUNDAMENTALS



OVERVIEW OF THE RSTUDIO IDE

Thorough tutorial regarding the RStudio console:
http://dss.princeton.edu/training/RStudio101.pdf

http://dss.princeton.edu/training/RStudio101.pdf


THE RSTUDIO CONSOLE

• Can type commands, arithmetic, 
functions, and other things here

• DOES NOT save code for future 
RStudio sessions

• > symbol means the command 
you typed begins here

• The [1] means the first value of 
the command’s results begins 
here



YOUR TURN!

1. Type the following command into the console.  What does the : operator in 
R do?

2:173

2. Type exactly what you see below in the console and then press Return.

table(iris$Species

3. Then type a right parenthesis and press Return.  What’s happening?



SOLUTION
1. Create a vector of integers starting at 2 and 

ending with 173.  (What do the numbers in 
brackets mean?)



SOLUTION
2. R displays a + prompt in 

the console if you type an 
incomplete command.

3. No big deal—Complete 
the command or press 
Escape to start a new 
command.



OTHER FUN CONSOLE STUFF
• Use # to comment part of a 

line or the entire line (get ready to 
comment way too much this semester)

• Use the STOP button on top 
of the console (or CTRL + c) 
to cancel a command

• You can change preferences 
by going to Tools→Global
Options



STORING OBJECTS

Use the <- assignment operator to store objects 
as variables.
• The Tidyverse Style Guide suggests using <-

for the assignment operator instead of =
o Yes, you can use either.  But…
o <- is typically used for assigning values to 

variables
o = is typically used for specifying parameter 

values in functions
• Type the variable’s name and press Return to 

display the variable’s value after assignment

https://style.tidyverse.org/syntax.html#assignment


MORE ON STORING OBJECTS
• Variables appear in the Environment pane after 

assignment

• Variable names must:
o Begin with a letter or a period (there’s more to 

this)
o Only contain letters, digits, periods, and 

underscores
o Reserved words in R cannot be used (e.g., TRUE)

• Tidyverse Style Guide: use snake case for variable 
names

https://en.wikipedia.org/wiki/Snake_case


EVEN MORE ON STORING OBJECTS

• Keyboard shortcut for the <-
assignment operator: ALT + -

• R is case sensitive!

• R overwrites variable names

• Use ls() to list all object names

• Use rm() to remove objects



YOUR TURN!

1. Create a vector of integers from 1 to 30 (inclusive).  Call it 
integer_vector.

2. Use the command c(0,1) to create a separate two-element 
vector consisting of 0 and 1.  Call it binary_flag.  (What 
does the c() function do?)

3. Multiply your two vectors.  What do you notice?



SOLUTION
1.
2.

3. R performs element-
wise execution, recycling 
vectors as needed.



FUNCTIONS

• Type the function name and enter 
value(s)/data in the parentheses

• Data passed into a function is called the 
function’s argument

o Arguments can be results from 
another function

o Use = to specify names of 
arguments, especially with multiple 
arguments for readability/QA



MORE ON FUNCTION ARGUMENTS

• R yells at you throws an error when 
you specify an unknown argument

• Use args() to look up a functions 
arguments

• Unless you specify arguments by 
name, R matches values to 
arguments in the function by order



GETTING HELP
# provides details for specific function

help(sqrt) OR ?sqrt

# provides examples for said function

example(sqrt)

# search help documentation if you forget the function’s name

??sqr

External to R:
Google: just add "with R" at the end of any search.
Stack Overflow: a searchable Q&A site oriented toward programming issues. 75% of my answers come from 
SO
Cross Validated: a searchable Q&A site oriented toward statistical analysis.
R-bloggers: a central hub of content from over 500 bloggers who provide news and tutorials about R.

https://www.google.com/
http://stackoverflow.com/
http://stats.stackexchange.com/


YOUR TURN!

1. Look at documentation for the quantile function.  What 
does the na.rm argument do?

2. Use the quantile function to find the 25th and 75th

percentiles of the integers 1 through 297.



SOLUTION



SCRIPTS

• Place code in a script to save for later use/editing/additions

• Open a new script by going to File→New File→R Script

• Different ways to run code in a script

o Clicking the Run button to execute the line of code the cursor is on (or 
the line(s) of code that you highlighted)

o Ctrl + Enter to run the line/block of code that’s highlighted or that the 
cursor is on

o Run the entire script by pressing the Source button



SET YOUR WORKING DIRECTORY

# get your current working directory

getwd()

[1] "/Users/Xiaorui/Dropbox/UC/BANA7025"

# set your working directory

setwd("/Users/ Xiaorui/Dropbox/UC/BANA7025")

getwd()

[1] "/Users/ Xiaorui/Dropbox/UC/BANA7025"

Keeping your files organized is critical



YOUR TURN!

Set your working directory to the “Session 01” folder 
you downloaded for this class.



PACKAGES

• Everything we’ve discussed so far is considered “base R”, which means we 
do not require additional capabilities to use these functions

• Packages are collections of custom functions and objects that extend the 
capabilities of base R

• Examples of packages you may have seen already:
o dplyr (useful for data manipulation)
o ggplot2 (useful for visualization)



INSTALLING PACKAGES

# install packages from CRAN
install.packages("packagename")

# install packages from Bioconductor
source("http://bioconductor.org/biocLite.R")            # only required the first time
biocLite()                                              # only required the first time
biocLite("packagename")

# install packages from GitHub
install.packages("devtools")                            # only required the first time
devtools::install_github("username/packagename")

The fundamental unit of shareable code is the package.
CRAN: 10,000+
Bioconductor: 1,000+
GitHub:  Many more plus beta versions for updated packages not yet published

So how do we install these packages?



Install these packages from CRAN:

dplyr

nycflights13

YOUR TURN!



SOLUTION

install.packages("tidyverse")
install.packages("nycflights13")

# alternative
install.packages(c(“tidyverse”, “nycflights13”))

For a full list of useful packages see this guide:  http://bit.ly/1x9vkzV

http://bit.ly/1x9vkzV


I INSTALLED A PACKAGE.  NOW 
WHAT?

• Installing packages simply downloads them onto your hard drive.

• Now you need to load these packages in order to leverage their 
capabilities.

• Important difference!
o You only need to install a package once (assuming the package hasn’t 

changed).
o You need to load a package every time you start an RStudio session.



LOADING PACKAGES
Loading packages:

# load the package to use in the current R session
library(tidyverse)

# use a particular function within a package without loading the package
stringr::str_replace()

Getting help on packages:

# provides details regarding contents of a package
help(package = "tidyr")

# list vignettes available for a specific package
vignette(package = "tidyr") 
browseVignettes(“KraljicMatrix”)

# view specific vignette
vignette(“tidy-data")



READ WARNINGS WHEN LOADING 
PACKAGES!



R OBJECTS



WHAT ARE ATOMIC VECTORS?

• The simplest data 
structure in R

• Linear vectors of a single 
data type

• Use is.vector() to test if an 
object is an atomic vector



WHAT ARE ATOMIC VECTORS?

• Four (actually there are six) types of 
atomic vectors

• Some R functions (and 
most people) refer to 
doubles as numerics

• Use is.*() to test if an 
atomic vector is a certain 
data type



CREATING VECTORS
• Use the c() function to combine 

values into a vector (or a list)

• Can use many operators or 
functions to create numeric 
vectors

• Integers are stored as numerics
by default.  Use an uppercase L 
after each integer to store as an 
integer. 



QA EVERY DAY! CHECK VECTORS

• Use length() to find 
the number of 
elements a vector has

• Use typeof() or class() 
to identify the type of 
atomic vector



YOUR TURN!

1. Look at documentation for the runif() function.

2. In your script for today’s class, create a vector with 75 observations that come from a 
uniform distribution with a minimum value of -3 and a maximum value of 14. (Don’t 
forget to assign this vector to a variable.  You pick the name!)

3. Write functions to examine this vector:
• Is it an atomic vector?
• What kind of vector is it?
• How long is the vector?



SOLUTION
# look at documentation
?runif
help(runif)
args(runif)

# create vector
runif_vector <- runif(n = 75,

min = -3,
max = 14)

# examine the vector
is.vector(runif_vector)
typeof(runif_vector)  OR class(runif_vector)
length(runif_vector)



ATTRIBUTES

• Attributes are information 
you can attach to an R object

• Attributes will not appear 
when displaying an object or 
affect object values

• Check for attributes with 
attributes()



THE NAMES ATTRIBUTE

• View the names of each 
element with names()

• Assign or change names with 
(usually) a character vector

• Remove value names by 
assigning a NULL (missing) 
value to names



VECTOR COERCION

• Combining different data 
types or forcing functions 
on certain data types 
results in coercion

• Vector coercion in R 
always follows a 
predetermined procedure



VECTOR COERCION EXAMPLES

Forcing functions on data 
types coerces vectors

Vector coercion isn’t always 
a bad thing!



FUNDAMENTAL DATA STRUCTURE
Matrix

• Two-dimensional 
array

• Numeric data only

• Use the matrix() 

function to create a 
matrix



YOUR TURN!

1. Look at documentation for the matrix() function.

2. Create a 5x4 matrix of the integers from 1 to 20, filling by 
rows.  Save the matrix as a variable called example_matrix.

3. Examine the names, class, and dimensions of this matrix.



SOLUTION
# documentation for matrix()
?matrix

# create the matrix
example_matrix <- matrix(
data = 1:20,
nrow = 5,
ncol = 4,
byrow = TRUE

)

# examine attributes
names(example_matrix)
class(example_matrix)
dim(example_matrix)



FUNDAMENTAL DATA STRUCTURE
List

• One dimension

• Each element can be its 
own object (a vector, matrix, 
data frame, or even a list)

• Use the list() function to 
create a list

• You’ll see lists frequently 
with linear models



FUNDAMENTAL DATA STRUCTURE
Data Frame

• Two-dimension version of a 
list (think of a spreadsheet)

• Named list of vectors with 
specific attributes

• Each vector become a 
column

• Vectors (i.e., columns) must 
be the same length in a data 
frame



FUNDAMENTAL DATA STRUCTURE
Data Frame

• Use the data.frame() function to create a data frame

• Data frames have a special data.frame class

• Use str() to examine the structure of a data frame



# example of data frame
cool_df <- data.frame(
# columns of data frame
observation = c("a", "b", "c", "d"),
rand_norm_value = rnorm(4),
exclude_flag = c(TRUE, FALSE, FALSE, TRUE),
# other options for data frame
row.names = NULL,
stringsAsFactors = FALSE

)

# examine data frame
cool_df
class(cool_df)
str(cool_df)



IMPORTING AND EXPORTING DATA

Importing Data

• Use the read.csv() function to 
read in .csv files

• Other read.* functions exist for 
various file formats

• Watch the stringsAsFactors
argument!

Exporting Data

• Use the write.csv() function to 
save .csv files to your hard drive

• Watch the row.names
argument!



STYLE GUIDE

I am a stickler for nicely formatted code



STYLE GUIDE

basic-stuff.r
detail.r

Naming scripts:

weather-analysis.R
emerson-text-analysis.R

Which is good, which is bad?



STYLE GUIDE

basic-stuff.r
detail.r

Naming scripts:

weather-analysis.R
emerson-text-analysis.R

Which is good, which is bad?

GoodBad



STYLE GUIDE

naming_convention
naming.convention 

Naming objects:

namingconvention
namingConvention
NamingConvention

Which is good, which is bad?



STYLE GUIDE

Which is good, which is bad?

Good Bad

naming_convention
naming.convention 

namingconvention
namingConvention
NamingConvention

Naming objects:



STYLE GUIDE

#################
# Download Data #
#################
lines of code here

###################
# Preprocess Data #
###################
lines of code here

########################
# Exploratory Analysis #
########################
lines of code here

Organization:

lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
lines of code here



STYLE GUIDE

#################
# Download Data #
#################
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###################
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###################
lines of code here

########################
# Exploratory Analysis #
########################
lines of code here

Organization:

lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
lines of code here
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Good Bad



STYLE GUIDE

average<-mean(feet/12+inches,na.rm=TRUE) 

Code spacing:

average <- mean(feet / 12 + inches, na.rm = TRUE)

Which is good, which is bad?



STYLE GUIDE

average<-mean(feet/12+inches,na.rm=TRUE) 

Code spacing:

average <- mean(feet / 12 + inches, na.rm = TRUE)

Which is good, which is bad?

GoodBad



WHAT TO REMEMBER



FUNCTIONS TO REMEMBER

Operator/Function Description

help(), ?, example() Get help on functions and provide examples

getwd(), setwd() Get and set your working directory

+, -, *, /, ^ Arithmetic

<- Assignment operator

ls(), rm() list and remove objects in your global environment

install.packages(), library() Install and load packages

vignette() View/list package vignette




